Honeywell

Excel LONSPEC™ Software
VER. 05.01.00

SOFTWARE RELEASE BULLETIN

A. 0.S. NUMBER: ZL7760A 1020

B. DESCRIPTION: LONSPEC™ is a Windows® based application used for the configuration, commission, monitor and
calibration of the following Honeywell Excel 10 and Excel 15 controllers:
W7750A and B Excel 10 Constant Volume Air Handling Unit (CVAHU), W7751B, D, F, and H Excel
10 Variable Volume Air Handling Unit (VAV), W7761 Excel 10 Remote Input/Output (RIO) device,
W7753A Excel 10 Unit Ventilator (UV), W7762 A and B Excel 10 Hydronic controller, W7763C
Excel 10 Chilled Ceiling controller, W7752D, E, F, G, and J Excel 10 Fan Coil Unit Controller,
W7760A Excel 15A Building Manager, Excel 15C Plant Controller, S7760A Excel 15 Command
Display (CD), T7300F/Q7300H Series 2000 Commercial Thermostats with Communicating
Subbase, T7350 Commercial Thermostat with Communicating Subbase, Q7790A Wireless
LONWORKS® Receiver with T7790C Wireless Wall Module, CXS/CXL Honeywell Variable
Frequency Drive Interface, and LONMARK® (third party) devices that meet standard profiles with
“XIF” files (NX Variable Frequency Drive (NX VFD).
Supported network interfaces are: Q7770A1001 RapldLlnk , Serial LonTalk Adapter (SLTA-10),
PCLTA-10, PCLTA-20 and PCC-10.

C. DISTRIBUTION
MEDIA: One CD-ROM.

D. SOFTWARE
REQUIRED: Microsoft® Windows® 2000 Professional Edition with Service Pack (SP) 3 OR
Microsoft® Windows® XP Home Edition or Microsoft® Windows® XP Professional Edition with
SP1or SP3 and a CD ROM drive.
Microsoft® Internet Explorer 6.0 with SP1
Software Protection
The software is subject to Copyright protection.

E. HARDWARE
REQUIRED: Personal Computer (PC) with:
. 500 MHz microprocessor or better (faster processor speeds will provide better performance)
. Minimum 128 megabytes (MB) of RAM.
Minimum 100 MB of available disk space.
. Super VGA monitor with minimum 1024 x 768 resolution.
. For communication with a directly connected local site, use any one of the following
LONTALK® Adapters:
* External RapldLlnk W|th standard RS232 9 pin male to 9 pin female cable
« External Serial LONTALK® Adapter, SLTA-10, FT-10 (O.S. Number Q7760A2001) with
standard RS232 9 pin male to 9 pin female cable
« Internal LONTALK® Adapter PCLTA-10, PCLTA-20 FT-10.
— Internal LONTALK® Adapter for laptops, PCMCIA PCC-10, FT-10 (O.S. Number
Q7752B2009).

PO TD

NOTE: Recommended for best results - External RapidLinkTM with standard RS232 9
pin male to 9 pin female cable.

f. For a Local connection, use the standard RS232, 9 pin male to 9 pin female cable
g. For a Remote connectlon use any one of the following:
* Honeywell RapldLlnk with a telephone line connection.
» Special NULL modem cable(s) (O.S. Number: 32002517-001).
» External Modem(s): 3Com U.S. Robotics 5686D, V.90/V.92 56K Standard compatible.
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EXCEL LonSPEC™ SOFTWARE

* Honeywell XM500-US TCP/IP modem for LAN/WAN connection, instead of telephone line
connection.

NOTES:
* Recommended for best results - Honeywell RapidLinkTM with a telephone line
connection
+ If an Excel 15B is available in the network, LONSPEC™ can remotely connect to
Excel 15B over TCP/IP or PPPoE and communicate with other devices using
Excel 15B as the network interface.

F. INSTALLATION
INSTRUCTIONS: Before beginning the installation procedure on a PC, make sure that one of the operating systems
mentioned in section D is already loaded. Set the screen resolution to 1024 X 768 minimum and
select small fonts.

IMPORTANT
* [tis prudent and recommended that project databases be duplicated in another directory
before doing any file manipulation. To do this, locate your project databases, copy and
paste the file at the location of your choice.
» Ensure that the logged on user has administrative privileges on the local machine. (It is
not necessary to be the network administrator if it is a LAN).

NOTE: If the upgrade is from a previous version of LONSPEC™, perform the following steps
one and two before loading the operating system onto the same PC.

1. Before installing LONSPEC™, backup all project files and then delete them from the existing
LONSPEC™ tree:
a. Go to ‘Project’ > ‘Backup’ in LONSPEC™.
b. Follow the directions when naming the files (no file extension is required).
c. If you are backing up the file on a hard drive, give it a temporary file name.
2. Go to ‘Start’ > 'Setting’ > 'Control Panel’ and select the ‘Add/Remove Programs’ icon. The
Add/Remove Programs window is displayed.
Select the LONSPEC™ application and click ‘Remove’ to uninstall the older version of
LONSPEC™. (Do not delete the directory where LONSPEC™ was originally installed.)
Turn off or reset any anti-virus software on the PC and exit any Windows® programs that is
currently running in the PC.
5. Insert the LONSPEC™ CD into the CD-ROM drive. Setup will launch automatically.
* If Setup fails to launch automatically:
— Go to ‘Start’ > 'Run’. The ‘Run’ dialog box is displayed.
— Type d:setup where d: is the letter of the CD-ROM drive and then click ‘OK’.
Result: Setup begins by displaying a message that it is preparing an installation
wizard. A ‘Welcome’ screen is then displayed followed by a reminder that you need to
exit all Windows® programs and turn off any anti-virus software.
6. Select the location where you want LONSPEC™ to be installed and click ‘Next>’ to begin the
installation.
Result. Setup installs the application at the specified location and adds the LONSPEC™ icon to
the Windows® Desktop and also to the ‘Programs’ menu.
7. Restart the PC after LONSPEC™ is installed, for successful operation.
8. Launch LoNSPEC™ 05.01.00.
9. Go to ‘Project’ > ’Batch Restore’ to restore the project files that were backed up (refer step 1).
0. After restoring the project(s) files, view the log file. Carefully read all the details in the log file
and make all the recommended corrections.
11. If the projects are restored successfully, then open the project with LONSPEC™ 05.01.00.

Lol
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G. HARDWARE

COMPATIBILITY:

EXCEL LonSPEC™ SOFTWARE

LONSPEC™ currently allows the configuration of the following controllers:

W7760A
W7760C

W7750A,B,B Enh,C

W7751B,D,F,H
W7753A
W7761A

T7300F/Q7300H
S7760A
Q7790A
CXS/CXL
Q7760A
W7762A,B
W7763C
W7752D,E,F,.GJ
Q7770A

W7760B

T7350
NX VFD

Excel 15A W7760A Building Manager
Excel 15C W7760C Plant Controller

Excel 10 Constant Volume, single zone, Air Handling Unit (CVAHU)
controller.

Excel 10 VAV 1I
Excel 10 Unit Ventilator (UV) air terminal units.

Excel 10 Remote I/O (RIO) device. Provides extra input/output points to
Excel 15 controllers.

Series 2000 Commercial Thermostats with Communicating Subbases.
Command Display version 1 and Command Display version 2
Wireless LonWorks® Receiver

Honeywell Variable Frequency Drive

Serial LonTalk® Adapter, SLTA-10, FT-10
Excel 10 Hydronic Controller

Excel 10 Chilled Ceiling Controller

Excel 10 FCU Controller

RapidLink Dialup Network Adapter external network interface with built in
modem for remote communication and a RS232 connection for serial
communication.

Excel 15B Phase 2 Honeywell Building manager - Provides easy and secure
Web-based interface and, via LonSpec™, can commission Excel 15B, Excel
10s, Excel 15Cs and NX VFD over TCP/IP and PPPoE.

Commercial Thermostat with Communicating Subbase
NX Honeywell Variable Frequency Drive (NX VFD)
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H. SOFTWARE

COMPATIBILITY: Refer to the compatibility matrices:
~
~
N
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BIBIB|E [« x|2|3|3 x|x|2|3 %2125 ISP 2757
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ElE|lE|lE|=|=|(§|§|§|olololo|lo|lolol|lE|lE|lE|lE|IE|E|E
< |x|x|x|x|S|EINIFIN|E|2 &2 |&|EIZ|E[I2|IEIZIE|F
Compatibility |< i |oi |5 (6|2 9|2 2|52 (2(2(2(2(|2(2|2(2(2(|2(2(2|2
Matrix 88|8|18|8|3|3|8|&8|8|8]|8|8/8/8(8|8|5|58|58/8|58|8|8
CD1.x a |a |a |a VIVININN N t ot |t [t [t |t
CD 2x t |t [t NN NNV WYY t [t [t |t [t
(firmware 2.1.9)
CD 2x t |t NN N NN t [t [t [t
(firmware 2.2.6 & 2.2.7)
CD 2.x (firmware 4.2.x) t v W v Y t o[t
Excel 15A 1.x b la [a |a |a VNN NN tot [t [t [t |t
Excel 15A2.x t o[t [t NEERR NNV WYY t [t [t [t |t
(firmware2.4.40/lower)
Excel 15A t o[t [t NEERR v VW t [t |t
(firmware2.4.50/higher)
Excel 15C 1.x t o[t [t NEERR NNV WYY t o[t [t [t |t
Excel 15D 1.x t o[t [t NN t o[t [t |t [t
Excel 10 CVAHU t [t [t [t NNV VWY toft [t |t [t [t
Models A,B
Excel 10 CVAHU t [t v NNV (Y toft [t |t
Models B-enh,C
Excel 10 UV t [t [t [t NN N NN t o[t [t |t [t [t
Excel 10 RIO t [t [t [t NN NNV WY t o[t [t |t [t [t
Excel 10 VAV t o[t [t c |c |ed NN WYY t [t [t |t [t
Excel 10 FCU t v W t o[t
Excel 10 HYD t v W t |t
Excel 10 CHC t R t |t
T7300/Q7300 t [t [t [t t [t NNV NN YN t o[t [t |t [t [t
T7350 t N t
NX VFD t N t
T7790C & Q7790A t [t NNV WY toft [t |t
Honeywell VFD t |t NN VN t |t |t |t
Q7770A1001 RapidLink N t
W7760B2001 N t
Excel 15B Phase 2
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t Interoperable: Devices can coexist; Sites engineered by one tool can be accessed by the other;
The given tool can support the noted device.
' The given device can be configured by the noted tool.
@ When upgrading firmware or replacing CD1.x, the Excel 15A must also be upgraded with the
latest firmware. Both chips are available for purchase.
When upgrading firmware or replacing Excel 15A 1.x, any associated CD1.x must also be
upgraded with the latest firmware. Both chips are available for purchase.
¢ RapidZone only configures two models of the Excel 10 VAV, the W7751H & W7751J
4 The smart actuator model of VAV (v1.02.14) supports the T7560 wall module.
RapidZone3.0 supports T7560 wall module configuration.




NOTES:

— Users must have all the following versions or higher to use the Site Status Reporting feature: LONSPEC™ 3.2,
LonStation 3.2 and Excel 15A 2.4.50.

— Excel 15A firmware v02.04.61 or above provides support for the Q7770A1001 RapidLink Dialup Network Adapter.

TOOLS

EXCEL LonSPEC™ SOFTWARE

COMPATIBILITY

MATRIX:

> > = 5 > 8 2
AR EEEE R
PC Software % % E :%J § :I?: ;‘; g :I?; ;‘; 5 5 c% 5 5 <'r<_:> c%
Qo Q [=% = = =2 = = =2 = = = = = = =2 =
Compatibility Matrix | & | &| &| 8/ 3(53|5|5|/53/53|5/53/3/53|53|53|5
RapidZone 1.x a |a |a |a t |ttt
RapidZone 2.x a |a |a |a toft |t
RapidZone 3.x fg |fg t |t
LONSPEC™ 1.x b |b [b |b t c
LONSPEC™ 2.x b |b |b t d
LONSPEC™ 3.1.x b |b t |t e
LONSPEC™ 3.2.x b t e
LONSPEC™ 4 .x to|t
LONSPEC™ 4.6.5 b t
LONSPEC™ 5.1.0
LONSTATION™ 1.x
LONSTATION™ 2.x
LONSTATION™ 3.1.x foof
LONSTATION™ 3.2.x fof
LONSTATION™ 4.x
LONSTATION™ 4.6.0
LONSTATION™ 5.1.0

@ The user can migrate a RapidZone database to LONSPEC™ 3x/4x to benefit from new
capabilities. Once done, it is not possible to go back to RapidZone with the database.
The user can backup and restore any database into a later version of LONSPEC™

(follow TAC tip C02-004). Always review the error log and make any changes noted there.

LONSPEC™ 1.x databases must be backed up and restored into LONSPEC™ 4.x before
association with LONSTATION™ 4 x.

LONSPEC™ 2.x databases must be backed up and restored into LONSPEC™ 4.x before
association with LONSTATION™ 4 x.

LONSPEC™ 3.x databases must be backed up and restored into LONSPEC™ 4.x before
association with LONSTATION™ 4 .x.
This involves a three step process:
* Import osmsitemgmt.mdb from the PC with previous version of LONSTATION™ into the PC
with newer version of LONSTATION™ (4x and above).
* Restore the LONSPEC™ databases (3x and lower versions) into LONSPEC™ 4.x. Import the

LONSPEC™ databases into LONSTATION™ 4x or above. This automatically associates the
LONSPEC™ database with LONSTATION™.

» Backup graphics from the PC with LONSTATION™ 3.1.x/3.2.x and restore them into the PC
with LONSTATION™ 3.2.x/4.x/5.x.

RapidZone 3.0 database can be restored into LONSPEC™ 4.x and onwards.

b
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J. APPLICABLE
LITERATURE:

74-2865-2 |LONWORKS® Bus Wiring Guidelines

95-7565-3 |Excel 15A Building Manager Installation Instructions

74-2967-2 |Excel 15A W7760A Building Manger Specification Data

74-2969-1 |Excel 15A W7760A Building Manger System Engineering Manual

95-7611-1 Excel 15C W7760C Installation Instructions

74-3079 Excel 15C W7760C System Engineering Manual

74-3080-2 |Excel 15C W7760C Plant Controller Specification Data

95-7521-4 |Excel 10 W7750A,B Constant Volume AHU Controller Installation Instructions

74-2958-1 |Excel 10 W7750A B Constant Volume AHU Controller System Engineering Manual

95-7504 Excel 10 W7751B, D, F VAVII Installation Instructions

95-7553 Excel 10 W7751H Smart VAVII Installation Instructions

95-7663-1 [Excel 10 W7751J Smart VAVII Installation Instructions

74-2949-1 Excel 10 W7751B, D, F, H VAVII System Engineering Manual

95-7520-1 Excel 10 W7753 Unit Ventilator Controller Installation Instructions

74-2964-1 |Excel 10 W7753 Unit Ventilator Controller System Engineering Manual

95-7539 Excel 10 W7761A Remote Input / Output Device Installation Instructions

74-2699 Excel 10 W7761A Remote Input / Output Device System Engineering Manual

63-2554-4 |CXS/CXL Honeywell Variable Frequency Drive User/ Application Guide

63-1285-1 |CXS/CXL Honeywell Variable Frequency Drive Specification Data

74-2989 W7763C Chilled Ceiling Controllers Specification Date

74-2934 W7762 A,B Hydronic Controllers Specification Data

74-2959-2 |W7752D, E, F, G Fan Coil unit Controllers

74-3425 Wireless LonWorks® Receiver Specification Data

95-7635 Wireless LonWorks® Receiver Installation Instructions

62-0155-3 |T7300F/Q7300H Series 2000 Commercial Thermostat and Communicating
Subbase Installation Instructions

63-4365 T7300F/Q7300H Series 2000 Commercial Thermostats and Communicating
Subbases System Engineering Manual

62-0195 T7350 Installation instructions Manual

63-1299 T7350 Specification Datasheet

63-2604 T7350 Owner’s Manual

95-7561-1 |Command Display Installation Instructions

74-2976-2 |Excel LONSPEC™ Specification Data

74-3069-2 |Excel LONSTATION™ Specification Data

95-7511-3  |Q7760A SLTA-10 Serial LONTALK® Adapter Installation Instructions

74-2954-2 |Q7760A SLTA-10 Serial LONTALK® Adapter Specification Data

95-7555-1 |Q7740A, B FTT Repeater Installation Instructions

74-2858-1 |Q7740A, B FTT Repeater Specification Data

74-3468-1 | XM500-US TCP/IP Modem for LAN/WAN Connection

95-7700-1 |RapidLink Dialup Network Adapter Product Data

74-3981 RapidLink Dialup Network Adapter Specification Datasheet

TAC Tip Technical Assistance Center Tip for Restoring Databases into later versions of
C02-004 LONSPEC™.

NOTE: For more information on NX VFD, refer to the VACON’s Website - www.vacon.com. All applicable Literature has been
included on the LONSPEC™ 05.01.00 CD-ROM. Refer to a directory labeled “Literature” where the literature will be listed
under the appropriate device name (i.e. W7760A). Adobe Acrobat Reader is required to view any of the literature and
has also been included on the LONSPEC™ 05.01.00 CD-ROM.
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K. APPLICATION
NOTES:

1.

EXCEL LonSPEC™ SOFTWARE

LONSPEC™ provides On-line help. Refer to the On-line help for the latest details, changes
and enhancements. The quick start guide provided with previous versions will not be
available.

In the ‘Communication Setting’ window, the ‘Port Used’ list displays only COM1 - COM10
ports.

Command Display(s) (CD) nodes must always be the last to be commissioned in a project.
This is because the CD's configuration is based on the nodes that are already commissioned
in that project.

Commission Excel 15A after its associated Excel 10(s) have been commissioned. This
ensures that the alarms received from the Excel 10(s) are processed with the appropriate
configuration choices.

If the SLTA-10 powers off while LONSPEC™ is communicating to a node on the network, close
LONSPEC™ and reset power in SLTA-10.

To easily identify the Time Master in a project, name that device/node with a prefix or suffix of
TM - for example, tm_kitchen or kitchen_tm.

To easily identify the Power Master in a project, name that device/node with a prefix or suffix
of PM - for example, pm_hallway or hallway_pm.

If a controller stops responding (due to power failure) during LONSPEC™ data transmission,
LONSPEC™ might become unresponsive. To re-establish transmission, reset the controller
and restart LONSPEC™.

Use the “Re-Commission” option to re-download configurations to controllers.

If LONSPEC™ is located on site and a local SLTA-10 is connected to the PC running
LONSPEC™, set dip-switch 5 up and all others down. No other setup is required.

When configuring a SLTA-10 at a remote site for modem applications, the remote modem
must be powered up before the SLTA-10 is powered up. The SLTA-10 sends a set-up string
to the modem when it is initialized. If the modem is not set to receive this set-up string the
modem will not work. To improve the robustness of connection between the remote modem
and SLTA-10, use the following procedure:

Preparatory Requirements

A standard RS 232 DB-9 male to DB-9 female cable from a laptop or PC to the SLTA-10
intended for on-site use.

Procedure for programming the SLTA-10 at a remote site with LONSPEC™ 05.01.00

PN

N

10.

Set dip switch 5 to the up position and all others to the down position on the SLTA-10.
Connect the SLTA-10 to the PC’s serial port.

Open the project created in LONSPEC™ for the site (must have an SLTA-10 in the project).
Go to ‘File’ > ‘Communication Settings’ and select the following: COM port to which the SLTA-
10 is connected, baud rate of 38400 and connection type as Direct.

Right click the site and connect to the network (or go to ‘Network’ > ‘Connect’).

Right click the SLTA-10 and select the ‘Commission SLTA’ option.

Select SLTA-10 from the list of devices and click ‘Add’ to move it to the selected list.

Click ‘Start’. A message is displayed prompting you to confirm if SLTA-10 is directly
connected to the PC. Click ‘Yes’ to confirm the same and wait for the success/failure
indication in the Status window.

If the commission process fails, check the cables and DIP-switch settings, make the
necessary corrections and repeat steps 1 through 6.

Set DIP-switches 2, 6 and 8 to the up and all others to the down position on the SLTA-10.
This will set the SLTA-10 for remote host (2 Up) at 38.4K baud (6 and 8 Up).

NOTE: If SLTA-10 is already installed at the remote site, you might have to perform steps
5 and 6 remotely. This is not a robust method and therefore is not recommended.
Instead, connect to the remote site using a modem and when prompted if the
SLTA-10 is directly connected, click ‘Yes’.

IMPORTANT

After programming the SLTA-10, do not change dip switch 4 and cycle the power.
Otherwise, steps 1 through 6 above must be re-executed.

At remote site, perform the following:

a. Connect the modem to the SLTA-10 with the special modem cable. (Honeywell part
number 32002517).

b. Set DIP-switches 3,4 and 8 to the down and all others to the up position on the US
Robotics V.90, 56K baud External modem.

c. Verify that the DIP-switch settings on the SLTA-10 are set according to step 9.
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d. Cycle the power, first to the modem and then to the SLTA-10 (This sequence loads a
string from the SLTA-10 into the modem for proper communication).

e. Set dip switches 3,4 and 8 Down and everything else Up on the U.S. Robotics V.90/V.92,
56K baud External modem.

f. Verify that the dip switch settings on the SLTA-10 are set according to step 8 above.

g. Cycle power, first to modem and then to SLTA-10 (This sequence loads a string from the
SLTA-10 into the modem for proper communication).

11. If a LAN/WAN is used instead of telephone lines to communicate with sites, refer to the
LONSTATION™ 04.05.09 help file under “WAN Modem Setup” for complete setup and
checkout instructions. The help file covers the complete process, in detail, with screen shots
for both the PC WAN modem and the site WAN modem(s).

RapidLink™ Replacement Procedure:
The foIIowmg section explains the detailed procedure to replace the SLTA + Modem with
RapldLlnk and the dependencies and changes required to upgrade the site with RapldLlnk

Excel 15A firmware Upgrade:

1. Sites, with Excel 15A controller, need to be upgrade with the Excel 15A firmware. The sites
that do not have Excel 15A controller can ignore Excel 15A firmware upgrade steps.
Switch off the Excel 15A controller.

Replace the EEPROM with the new chip that has Excel 15A firmware version 02.04.61 or
higher (which supports RapldLlnk )

Power on the Excel 15A controller and wait for couple of minutes.

Verify if the Excel 15A LED blinks or not.

ahr wDd

NOTE: The Excel 15A firmware upgrade does not require commissioning of Excel 15A
controller.

Phy3|cal Replacement of (SLTA + Analog Modem) with RapidLink:
Switch off SLTA-10 and Analog Modem.
Remove the power supply adapters from the modem and SLTA-10.
Remove the Null-Modem cable that connects the modem and SLTA-10.
Remove the Telephone line connected to the Modem.
Disconnect the LON® cable (E-Bus) connected to the SLTA-10.
Take out the RapldLlnk from the packing box and note the RapidLink™ Neuron® ID.
Fix or place the RapidLink ™ inside the panel or keep in a place within the reach of the LON®
cable.
8. Connect the LON® cabIeASE Bus) to the RapidLink E-bus port.
9. Power on the RapidLink . The power supply must be in the following range - 9V AC/DC to
24V AC/DC, 250mA, 50/60 Hz, NEC Class 2 wiring only.
10. Verify that the RapldLlnk power LED is on.
11. Switch off the RapldLlnk reconnect the telephone line to the RapldLlnk then power the
RapldLlnk again.

NoaprwNb=

Commissioning of RapidLink:

Install LONSPEC™ 05.01.00 and restore the project files

Open the Project of your choice from LONSPEC™.

Right click on the SLTA-10 and select ‘Replace SLTA with RapidLink’.

Type the Neuron® ID of the RapldLlnk that will replace the existing SLTA-10. Rename the
RapldLlnk if required. Note that the process of replacing the SLTA-10 with RapidLink™
takes care of the process of replacing the Network Interface in the Excel 15A General Dialing
Information screen.

Select the Remote option for connecting to the Site.

Connect to the Remote Site. o

Once connection is established, right click on the same RapidLink = and select the
‘Commission RapidLink’ option. LONSPEC™ prompts you with the following question, “Is the
Network Interface RapidLink_xx connected directly to your PC*?

8. Select ‘Yes’ to confirm.

9. After commissioning the RapidLink disconnect the site.

Pob=

Noo
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UPLOAD LIMITATION

Controller Information
Controller Information Uploaded Not Uploaded

Excel 10 Controller

* Al configurable network variables and Memory file variables. * Network images (Network
selector table, address
table, domain table).

* Binding information with
other controllers.

Excel 15C Plant Controller

* Al configurable network variables. * Network images (Network
* The File variables for the following areas: selector table, address

* 10 configuration. table, domain table) are

* Control Loop configuration (except binding). not uploaded.

* General Poll table. * Binding information with

* Logic loop configuration. other controllers.

*  Object name table.

+  Start/Stop loop configuration (except binding).

* User attribute name table.

Math Function configuration.

Information uploaded with respect to Configuration screens:

Analog Input (100%).

Digital Input (100%).

Analog Output (100%).

Digital Output (100%).

Setpoint (100%).

Math Function (LONSPEC™ does not update the internal table for associated RIO remote points. Network special math
function bindings are not updated. Therefore these bindings are not saved).

+ Start Stop Loop (LONSPEC™ uploads the configuration but does not update internal tables so the bindings for “Bypass”,
Disable Loop”, and “Start Stop Output” would not be saved).

Control Loop.

Input (internal tables and bindings are not updated for remote points).

Reset & Recovery (100%).

Setpoint (100%).

Setpoint override (internal tables and bindings are not updated for remote points).

Control Parameters (100%).

Setpoint Alarms (100%).

Sequencer (100%).

Logic Loop (Configuration is uploaded but internal tables and binding tables are not updated for inputs and outputs that
are remote points).

9 74-3961—2
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Controller Information Uploaded

Controller Information
Not Uploaded

Excel 15A Building Manager

All configurable network variables.

File variables for the following areas:

Alarm Configuration

10 configuration

Demand Limit configuration

Remote dialing information

Exception and Holidays.

Control Loop configuration (except binding).

General Poll table

Logic loop configuration

Object name table.

Start/Stop loop configuration (except binding).

Schedule information

Trend and Bypass configuration

User attribute name table

Information uploaded with respect to Configuration screens

* General Page (Except power master and Time Master bindings therefore the power and time master configurations will

be lost.)

Analog Input page (100%)

Analog Output page (100%)

Digital Input Page (100%)

Digital Output Page (100%)

Schedule (100%)

Exception/Holidays (100%)

Schedule Assignment (LONSPEC™ does not update the internal binding table therefore the bindings for Schedule

Assignment will be lost).

*  Control loops (Except “Disable input” and Loop “Input/Outputs”. In this case LONSPEC™ uploads the configuration but
does not update internal table. Therefore the “Disable Input” and Control loop “input/outputs” would not be saved).

+ Start Stop Loop (LONSPEC™ uploads the configuration but does not update internal tables so the binding for “Bypass”,
Disable Loop”, and “Start Stop Output”. Therefore the bindings for “Bypass”, Disable Loop”, and “Start Stop Output”’
would not be saved).

* Logic Loop (LONSPEC™ uploads logic loop configuration but does not update internal tables for input assignment.
Therefore the remote input assignments of logic loop are not saved).

* Runtime (LONSPEC™ uploads configuration details, but does not update internal tables for remote runtime points.

* Trend configuration(100%)

* Bypass (LONSPEC™ uploads Bypass configuration but does not update internal tables. Therefore the remote bypass
points are not saved).

o Alarm:

DDC Alarm (100%)

Digital Alarm(100%)

Analog Alarm (100%)

General Alarm (Except “Alarm Annunciator Silence” and “Alarm Annunciator” are uploaded but internal table are not
updated).

Excel 10 Alarm Mapping (configuration is uploaded but internal tables and binding are not updated. Therefore all
bindings will not be saved).

DLC configuration (Except override for remote points. For remote point, internal tables are not updated. Therefore
remote override information would not be saved).

* General Dialing (100%).

*  Network images (Network

selector table, address
table, domain table).

* Schedule assignment,

External DLC assignment
and Excel 10 Alarm
mapping information.

* Binding information with

other controllers.
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L. APPLICATION
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DETAILS: LONSPEC™ Configuration Tool:

1. When using the LONSPEC™ ‘Create Network’ option to create a project from an existing
network containing third party devices, LONSPEC™ might not add the repeater to the network
after the sixtieth device even if it is a third party device.

2. LONSPEC™ supports Excel 15B interface for remote connection and RapidLink ™" Dialup
Network Adapter for serial and remote connections.

3. LONSPECT'VI supports the configuration and commission of Excel 15B and RapldLlnk

4, RapldLlnk is available in the General Dialing Information page of the Excel 15A Bwldlng
Manager conflguratlon screen; Excel 15A can dial out alarms to a workstation through
RapldLlnk

5. LONSPEC™ also provides an easy replacement of SLTA-10 with RapidLink " using the
‘Replace SLTA with RapidLink’ option. All the SLTA-10 selectlons made in Excel 15A dialing
information screens will automatically be updated with RapldLlnk devices. Excel 15A need
not be commissioned after this process but RapldLlnk must be commissioned.

6. LONSPEC™ allows offline configuration of Excel 15B alarms, trends, schedules and Demand
Limit Control (DLC) service.

7. LONSPEC™ can perform all online operations like commissioning, device upload, diagnostics

through Excel 15B.

W7760A Excel 15A Building Manager:
Excel 15A firmware version 02.04.61 provides support for RapldLlnk
The following issues have been resolved in the v02.04.61 firmware release:

1.

If the Flex and S/S loop disable loop input is not configured and the user checks the Reverse
checkbox, then the SBC disables the loop.

If this configuration is made, then the disable input is not considered.

It is possible to get a control loop Aux point stuck Off.

If a control loop is disabled just after the Aux point turns on, and the Aux point has a non-zero
minimum On time, the Aux point turns Off the next time the loop runs. However, if the loop is
enabled before the minimum On time expires, the Aux point remains Off. The expected
behavior is that the Aux point should turn on once the minimum On time has expired. This
has been fixed in this release.

Modification of Bypass Log Configuration is not resetting the logged data in the controller.

If there is a bypass value logged against some selected point and if that point is changed, the
controller is expected to reset the logged data. Instead it was adding to the previously logged
values. This is fixed.

Summary of Excel 15A Building Manager behaviors:

1.
2.

The Excel 15A blink rate is not constant. An irregular blinking LED rhythm should be ignored.

An alarm silence, implemented using a pushbutton momentary type switch, must be

configured as an Excel 15A digital input type Maintained. The user must hold down the alarm

silence pushbutton switch for a least 10 seconds.

In the Demand Limit Control (DLC) screen, the Max Shed Time field is set to 100 for

Off Continuous, 101 for Last Resort, and 1 to 99 for Rotating.

If a local analog input on the Excel 15A is configured for outdoor air temperature or humidity,

do not use the network outdoor air temperature or humidity as an input to other functions on

the Excel 15A, instead use the configured local analog input.

The network outdoor air temperature and humidity are not automatically connected between

devices/nodes on a network. This can be accomplished while the project is offline:

a. Click the Refer Points button.

b. Choose the Source Controller as the node with the configured outdoor air temperature or
humidity input.

c. Highlight the Outdoor Air Temperature or Humidity in the Source Controller points list box.

d. Highlight the particular device in the Destination Controllers.

e. Select OdTempln or OdHumIn as appropriate and click the Add button.

Electrical noise on the analog inputs that does not affect control, could be seen in a trend log

or could cause intermittent alarms if the alarm pre-delay time is set to zero (0).

If a remote output has been assigned in a control loop configuration, and the remote output

configuration changes, no automatic checking for type match is done. For example, an RIO

output could be changed from discrete (digital) to float or modulated, but the connection to an

Excel 15A thermostat's stage one remains. Although the thermostat's stage one output

requires a discrete output to function properly, the physical output configuration of the RIO

changed. The user must manually correct the miss-match by re-assigning the thermostat's

stage one output or change the type of loop used. This is especially true when any input or

output configuration changes to Unconfigured.
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8. The trend and alarm buffers within the Excel 15A are reset once a new configuration is
downloaded. To prevent lost data, examine the trend and alarm history logs before
commissioning.

9. When configuring control loops, the I/O must be configured before entering parameters and
setpoints. If parameters and setpoints are entered first, the values are set in native units (SI)
and when the /O is entered with English units, the values are converted from metric to
English resulting in unexpected configuration values.

10. When configuring logic functions, the output engineering units must be specified. If no unit is
specified the output will have no engineering units assigned.

11. Some fields in the monitoring screen require a longer time to update the correct status.
Normally it takes a couple of minutes, after commissioning the controller, for the loop status to
be reflected correctly. Similarly, when the loop is put in the bypass state, the user will have to
wait longer for the status to be reflected in the effective occupancy. (This applies to both the
monitoring screen and point group monitoring.)

ALARMING:

1.  While commissioning an Excel 15A, if the error “Error in Selector Table Download Continue
Selector Download?” is displayed, the user will be prompted to either continue with the
download or not. If No is selected, LONSPEC™ will abort the commission for that controller and
attempt to put it in the Configured On-line state. If neither option is chosen, the message will
time out and default to No. LONSPEC™ will log the error as Error in Commissioning
<controller name> during selector download. Wait at least two minutes before attempting to
commission that controller again. After waiting two minutes and trying to commission the Excel
15A and still getting the error message, the node is either offline or not responding. Abort the
operation, cycle power to the Excel 15A and try to commission it after two minutes (this allows
the controller time to put itself back online). If the same error message is still displayed, the
node is either offline or not responding. Abort the operation, cycle the Excel 15A power one
more time and try to commission the controller after two minutes. If the commission still fails,
go to the Device Status report and select the Excel 15A controller from the device list and
scroll over to display the Node State. If it is not Configured/On-line, then select the button
Set Config/Online (with the Excel 15A still highlighted) and try to commission the Excel 15A
after two minutes. If the message Failed in setting controller state to Configured Online is
displayed while in the Device Status report or the error message Node is either offline or not
responding is displayed, abort the operation (while attempting the commission). The Excel
15A may be defective and should be returned to the distributor for replacement.

2. A checksum error (in the monitoring mode), indicates there was problem with commissioning
the Excel 15A controller. Corrective action is to commission that Excel 15A controller again.

3. Alarm text for remote data points from an RIO, an external Excel 15A, external Excel 15C, or
free points from an Excel 10 uses default text.

4. Alarm information is hidden in the alarm history log because the row width is not large
enough. This can be corrected by enlarging the row width.

5. LONSPEC™ will show only the default names for all remote points in Excel 15A Alarm/Trends
Configuration. For example, the user will be able to see only the default names for Excel 15C
remote analog inputs, Digital inputs, Control loops outputs, Start stop loops and Logic loops
and not the user defined names during Alarm/Trend Configuration.

Time of Day Scheduling:
1. When using an Excel 15A together with Q7300 Communicating sub-bases, the Excel 15A
should always be configured as the schedule master for proper operation.
2. No warning is given to indicate conflicting exceptions/holidays Schedules.
3. The TOD network variables are assigned according to the order listed in the Schedule Assign
screen. If the first assigned controller is selected to use schedule_5, then schedule_5 will be
sent on the first TOD network variable.

User Defined Names:

» User defined names are not supported in the configuration of analog or digital alarms.
Analog/Digital Alarm names are now configurable. User defined names of points from
remote controllers will not be displayed. Instead only default names will be displayed for
these points.

User Interface:

» 1/O data point connections are not completely removed when a node is deleted from a
project. When a node is deleted, manually delete any I/O data point connections used as
remotes in other devices. All bindings from/to a controller being removed are automatically
deleted.

74-3961—2 12
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W7760B EXCEL 15B BUILDING MANAGER:
The following are the error messages displayed under different scenarios when Excel 15B is the
network interface for LONSPEC™:

1.

“User authentication failed. Invalid user name or password”

If the user name and password entered during “Connect to Network” operation is invalid,
LONSPEC™ displays the above-mentioned error message.

“Failed to connect. Another LONSPEC™ application already connected to Excel 15B”.

If user tries to connect to Excel 15B from LONSPEC™ and if there is another LONSPEC™
already connected to it, LONSPEC™ displays the above-mentioned error message.
“Timeout occurred. Unable to receive response from Excel 15B”

If LONSPEC™ is not able to receive any response from Excel 15B during “Connect to
Network” operation, LONSPEC™ displays the above-mentioned error message.

W7760C Excel 15C Plant Controller:

1.

When using voltage or current analog inputs, if the sensor is not connected or a wire is
broken, “Invalid” does not display as the value. A value of zero “0.0” is valid input for voltage
and current. It is not possible for the controller to detect a broken wire or open sensor.

Any configured counters will not be reset following a full commission. The user will have to
use the “Reset Counters & Runtimes dialog box”.

W7761A Excel 10 Remote I/0 (RIO) device:

1.

2,

The Excel 10 RIO device supports PT3000, 20K NTC, and T7770, but not custom sensor
configurations.

In the Controller diagnostics screen for RIO, if the value of the Digital Outputs (DOs) are set
and then refreshed for a long period of time, the values of the DOs will change back to their
initial values.

S7760A Command Display Module:

1.

2.
3.

10.

The Command Display Module configuration cannot be uploaded from the device and does
not appear in the Upload controller list.

The Command Display (CD) Module cannot be unassigned.

Should network configuration change, fully re-commission the Command Display as follows:
a. Select “Assign Neuron ID” for the CD

b. Zero-out the Neuron ID

c. Press the service pin of the CD.

d. Commission the CD.

After controller replication (e.g. Excel 15A/ Excel 15C), all the replicated controllers will have
the same logical object names. When these names are downloaded to the CD, the user may
see several logical objects with the same names, which may lead to confusion. This limitation
is due to the way the screens are organized in the CD. To avoid this confusion, the CD should
be configured in such a way that the replicated controllers belong to different groups.

To receive and view the alarms on CD, the Excel 15A, which is the source of the alarms, has
to be selected in one of the configured groups in CD.

To view an Excel 10 alarm that has been mapped to an Excel 15A, both the Excel 15A and
the Excel 10 have to be selected in one of the configured groups in CD.

The user will not be able to associate multiple command displays in the network to receive
the same alarms.

The CD does not support displaying Excel 15a logic functions data values.

The manual occupancy override values of the following Excel 10 controllers: Chilled ceiling
controller, Hydronic controller, and Fan Coil Unit are not displayed properly in CD. The field
“override status” in CD displays effective occupancy status instead of actual manual override
status.

This happens only for the following Excel 10 controllers: Chilled Ceiling controller, Hydronic
controller, and Fan Coil Unit.

Earlier versions of LONSPEC™ would not put Command Display |l to NOT COMMISSIONED
state if any of the assigned Excel 15A or Excel 15C configuration changes. This version of
LONSPEC™ would automatically put the Command Display Il into NOT COMMISSIONED
state if any of the assigned Excel 15A, Excel 15C or Q7300's configuration changes.
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Q7790A RF Receiver:

1. Since Sensor Names are not downloaded to the controller, uploading the data from the RF
Receiver can not retrieve the user-defined names. The user-defined names are stored only in
the LONSPEC™ project database.

2. When configuring the Excel 10 for the wireless wall module (T7790C), configure the space
temp as ‘NetworkOnly’ and the Use Wall module as ‘No’ (no setpoint). If this is not done, the
Excel 10 will be in alarm (fast blink) because the controller checks for the actual setpoint pot
connection (valid resistance).

3. If the wireless wall module (T7790C) is bound with more than one CVAHU, the RF receiver
firmware does not raise the low battery alarm for all controllers that are associated with the
same controller.

W7750A, B, B enhanced, C Excel 10 CVAHU Controller:
* The order in which the Optional Outputs are selected in the Output tab in LONSPEC™ is not
preserved in the database. Though the user may see the order of the outputs changed, it is
of no consequence.

W7751B, D, F, H Excel 10 VAV Il Controller:
1. In the device status report for the VAV Il controller, occasionally, the last error logged may
display “NV Length Mismatch”. This message should be ignored.
2. LONSPEC™ enables the user to check if the Excel 10 VAV controller’s flow balancing is
performed properly. This option displays the calculated and actual flow linearization values.

Engineering Units:
1. A value of Zero is sometimes displayed as a small exponential number - for example
0.0056E-37
2. A Point group displayed using LONSPEC™ Monitor Network Group under the Network menu
item utilizes the point's native engineering units rather than those selected by the user for
Excel 15A analog inputs and RIO analog inputs configured to use voltage.

M. NEW FEATURES
IN THIS RELEASE: 1. LONSPEC™ supports T7350 and NX VFD controllers. All the configuration, monitoring and

diagnostics functions performed for other controllers are also applicable to these controllers.

2. Rapidlink Flasher, a utility tool shipped with LONSPEC™ Installation CD is now upgraded to
V2.0.1. It provides the ‘Rapidlink Internationalization support’ where in addition to upgrading
the firmware, the user can also use Rapidlink Flasher to download the country specific
modem settings to Rapidlink.

3. LONSPEC™ enables the offline configuration of 50 different DLC loads on the Excel 15B
Configuration screen. In addition to configuring, user can also do the following:
» Assign these loads to objects on the network (120 objects).

NOTE: DLC does not drive NX VFD directly. It is configured to drive an Excel 15C object,
which in turn can be configured to drive the NX VFD.

» Select an Excel 15C Plant controller as the Pulse Meter input. (User must ensure that only
the Excel 15C Plant controller that has a pulse meter attached to it is selected).

N. KNOWN ISSUES IN
THIS RELEASE: 1. Excel 15B commissioning in LonSpec fails when NX VFD is still not discovered by Excel 15B.

a. When NXVFD is not yet discovered by Excel 15B, select the NX VFD points in one of the
Excel 15B configuration screens in LonSpec.

b. Save the configuration and commission Excel 15B.
The commissioning fails as Excel 15B does not recognize the NX VFD point configura-
tions.

Work Around: Ensure that you complete one of the following before commissioning Excel

15B:

« Turn on NX VFD, make it available online and allow Excel 15B to discover NX VFD at
least once

* Do not select any NX VFD points in Excel 15B configuration screens and clear/delete
any existing NX VFD point selections.

74-3961—2 14
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1.

12.

13.

14.

15.

EXCEL LonSPEC™ SOFTWARE

Turn off and then turn on the power to RapidLink every time you upgrade the RapidLink firm-
ware from RapidLink Flasher. This ensures that RapidLink is in a good working condition.
It is rarely observed that when you configure a LoadName with 30 characters, LONSPEC™
automatically adds a special character at the end of the name. Also, when you revisit the
page under the ‘Load Assignment’ tab, LONSPEC™ displays the error message that the load
name must be a maximum of 30 characters. When Excel 15B is commissioned, the special
character is displayed as a colon on the Excel 15B DLC screen.
The order in which the configured T7350 holidays appear in LONSPEC™ is different from the
order in which it appears in the palm PC. For example, holidays 1to 6 in LONSPEC™
corresponds to holidays 5 to 10 in the palm PC.
The state of ‘nvoDigOut’ network variable (NV) is displayed as ‘OFF’ on the LONSPEC™
screen though they are physically ‘ON’ in the NX-VFD controller.
Sometimes LONSPEC™ doesn't display configured Excel 15C Loops for DLC Load Assign-
ments. Excel 15B immediately displays the configured loops after performing the ‘Refresh
Configurations’ operation. Consider the following scenario:
a. Connect LONSPEC™ to the network.
b. Configure some Excel 15C control/start-stop loops.
c. Commission Excel 15C Plant controller.
d. Configure Excel 15B DLC load in LONSPEC™ and assign the configured load to one of the
Excel 15C loops.
LONSPEC™ does not display the configured loops but Excel 15B does display them after
refreshing the ‘DLC::Load Assignment’ page.

NOTE: Itis a rare scenario and does not occur consistently every time this task is per-
formed.

The Excel 15B alarms and trends information in the Document Project report is not properly
aligned.

After configuring a DLC load, whenever you click the ‘UP’ arrow (Increment button)
LonSpec™ automatically creates a DLC load. When you commission the Excel 15B, these
loads are displayed as unassigned DLC loads on the Excel 15B DLC screen. When Excel
15B issues a shed command, all loads including the unassigned loads are automatically
shed. The following scenario explains this issue:

a. Configure one Excel 15B DLC load in LONSPEC™.

Click the ‘UP’ arrow 9 times to create additional 9 DLC loads.

Assign only one load to external objects.

Click the ‘View’ tab. All the other nine unassigned loads are automatically displayed along
with the assigned load.

e. Commission Excel 15B. All the unassigned loads are displayed along with the assigned
load on the Excel 15B DLC screen. When a shed command is issued, all the loads
(assigned as well as the unassigned loads) are shed.

LONSPEC™ can take up to 8 minutes to detect a network connection failure when connected

to Excel 15B. Reconnect to the network. For example, if there is a connection failure when a

controller is being commissioned, then you have to establish the connection again and re-

commission the controller.

When LONSPEC™ performs device discovery with Excel 15B as the network interface, Excel

15B will update LONSPEC™ with the list of all devices available in its device list. If any of these

devices are currently offline, LONSPEC™ displays the device name as ‘UNKNOWN'.

When connected to Excel 15B, if there is a network connection failure or an abnormal

termination on the LONSPEC™ side, LONSPEC™ cannot connect to Excel 15B immediately till

the 30 minutes timeout is over in Excel 15B.

Work Around: Wait for 30 minutes and then try connecting to Excel 15B again.

Sometimes the Wireless Receiver configuration screen displays 500 rows instead of 14 rows.

Closing and opening the configuration screen again will show the 14 rows properly.

The monitoring screens for Excel 10 Hydronic, Chilled Ceiling controller and Fan Coil Unit do

not display the correct Manual Occupancy value in the ‘Manual Occupancy’ field, under the

“Occupancy” tab.

Sometimes LONSPEC™ crashes while assigning the neuron ID using the ‘Use Service Pin’

option.

Excel 15A version 02.04.40 requires a pair of scheduled events every twenty-four hours for

successful operation. For example, if a user wants Occupied operation on Sunday and

Unoccupied operation Monday through Saturday, a Scheduled Occupied event followed by a

Scheduled Unoccupied event must be inserted each day, Monday through Saturday for

successful operation. This results in the equipment turning on during Unoccupied periods,
even if it only for a minute. In the reverse situation, the equipment turns off during Occupied
periods.

Work Around: Excel 15A can be upgraded to version 02.04.52 to correct this.

b
c
d
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16.

17.

18.

19.

O. LIMITATIONS: 1.

Event 1 Event 2 Event 3 Event 4
Sun 08:00 Occ 16:00 UnOcc
Mon 06:00 Occ 06:01 UnOcc
Tue 06:00 Occ 06:01 UnOcc
Wed 06:00 Occ 06:01 UnOcc
Thu 06:00 Occ 06:01 UnOcc
Fri 06:00 Occ 06:01 UnOcc
Sat 06:00 Occ 06:01 UnOcc 09:00 UnOcc

Furthermore, with Excel 15A version 02.04.40, the time between scheduled events must not
exceed 24 hours. In the previous example, if the occupied/unoccupied pair were scheduled at
6:00 a.m. and 6:01 a.m. respectively and the occupancy start time on Sunday were 8:00 a.m.,
then there would be a 25 hour and 59 minute gap between Saturday's unoccupied event and
Sunday's occupied event. In this case, the user should insert another unoccupied event
somewhere in the middle (e.g. 9:00 a.m. on Saturday).

Excel 15A version 02.04.52 requires a scheduled event every day for successful operation.
For example, if a user desires occupied operation on Sunday and unoccupied operation
Monday through Saturday, a scheduled unoccupied event must inserted each day, Monday
through Saturday for successful operation. Gaps of twenty-four hours between events are
permissible as long as at least one event is present per day.

Windows® XP provides multi-user access for applications. A logged in user can uninstall
LONSPEC™ when it is simultaneously being used by another user.

It is necessary to restart LONSPEC™ if the PC side modems are switched off when
LONSPEC™ is already launched.

The voltage input rating to the RapidLink™ should be within 9V-24V AC/DC, 50/60 Hz and
the minimum current rating should be not less than 250mA. The power supply to be used
must adhere to NEC Class 2 Transformer requirements.

At any given point of time, only one LONSPEC™ can be connected to an Excel 15B.

At any given point of time, T7350 scheduling is possible on only one object per Excel 15C
Plant controller.

LONWORKS®, LONMARK®, and LONTALK® are registered trademarks of Echelon® Corporation.

LONSPEC™ and LONSTATION™ are trademarks of Echelon® Corporation.

Microsoft® and Windows® are registered trademarks of Microsoft, Inc.
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